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NOTES 

This document is provided as a consultation manual intended for the device users. 
 

CEFLA s.c. follows a policy based on the constant development and update of the product. For this reason, it 

reserves the right to change the content of this manual without prior notice. 
 

This document can not be modified, copied, reproduced, distributed, saved on magnetic or optical supports, or 

published on websites and other on-line services, in full or in part, without the prior written authorisation of CEFLA 

s.c. 
 

The original version of this manual is in Italian. 
 

NEWTOM™ is a trade mark of CEFLA s.c. 

All other products and trade names mentioned in this document are registered marks of the relevant manufacturers. 

 

 

INFORMATIVE NOTE OF THE MANUFACTURER ON THE MEDICAL DEVICES 

The medical device referred to in this manual consists of a scanner and a control, display and calculation unit (Main 

Workstation). This device, as delivered and configured by the production and service technical staff, is a radiographic 

equipment compliant with the safety requirements outlined in Regulation (EU) 2017/745 on Medical Devices. 

 

The medical device referred to in this manual is an X-ray device compliant with Directive 2011/65/EU on the  

restriction  of  the  use  of  certain  hazardous  substances  in  electrical and  electronic  equipment. 

 

Any tampering with, modification, updating or other change both of hardware1 and software2 of the device as supplied 

and installed by the company (and in the conditions specified in the attached documentation) may partially or totally 

compromise the device expected operation. This may also alter the safety features with consequent hazard increase 

for patients, operators and surrounding environment. 
 

For this reason, should the user need to modify the device, he/she must request a written authorisation by CEFLA 

s.c. 
 

Failure to comply with what is specified in this informative note will null and void the device warranty and the civil 

and/or penal responsibility for any consequent damage and/or accident and/or worsening of the patient, operator or 

other people health (including the surrounding environment) will be borne by the person who tampered with the 

device or his/her legal representative. 

 

 

 

 

 

1 Adding of a new memory expansion, a new hardware on the connection bus, a printer, the replacement of the 
graphic display interface represents an important modification. 

 
2 Including the operative system and the applications already installed upon medical device delivery. Automatic 

updates of the operative system, changes to network connection parameters, modification and/or addition and/or 
removal of interface software with hardware (device driver) and/or services (e.g. file and printer sharing service) 
and/or applications represent an important modification. 
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1. INTRODUCTION TO THE MANUAL 
1.1. CONTENTS 

 

This manual has been conceived as a consultation document to provide information and instructions on the use of 

the NewTom™ VG series device, “NewTom VGi evo” model. 
 

The routine software operation set for this device (scanning, data processing, reporting and document management) 

and the use instructions for the operator are dealt with in the “Acquisition Operations with NewTom VGi evo” annex to 

the "NNT User Manual" document. 
 

The “USER MANUAL” of the device, "NNT User Manual" and “Acquisition Operations with NewTom VGi evo” should 

be read and understood in every part before starting to use the device. 
 

We recommend keeping this manual together with the other documentation and using it as a guide if new personnel 

must be trained on the use of the device. 
 

 

 

1.2. STRUCTURE 
 

The “User Manual” is divided into the following chapters:  
 

Chapter 1 – “INTRODUCTION TO THE MANUAL”:  

provides information on the contents, the structure and the conventions used in this document. 
 

Chapter 2 – “SAFETY-RELATED INFORMATION”:  

includes information concerning the safety of operators and patients and essential procedures for using the 

appliance. 
 

Chapter 3 – “DEVICE SAFETY AND MAINTENANCE”:  

includes information concerning safety requirements and maintenance operations of the device.  
 

Chapter 4 – “STARTING PROCEDURES”:  

provides a general description of the device and its main parts. 
 

Chapter 5 – “PRELIMINARY OPERATIONS”:  

explains the procedure for a correct device initialisation. 
 

Chapter 6 – “SCANNING”:  

explains the process to position and scan a patient. 
 

Chapter 7 – “QUALITY CONTROL”:  

explains the procedure for a correct Quality Assurance process. 
 

Chapter 8 – “TROUBLESHOOTING”:  

provides a list of malfunctions and possible solutions. 
 

APPENDIX A: TECHNICAL SPECIFICATIONS 
 

APPENDIX B: COMPATIBILITY 
 

APPENDIX C: DEVICE LABELS 

 
 

 

 

1.3. STYLISTIC CONVENTIONS 
 

Important safety-related information and notes are indicated in the manual as follows: 
 

 

HAZARD: 

Informs about the presence of a potential hazard that may lead to personal injuries or even death. 

  

 

WARNING: 

Warns about the presence of a potential hazard that may damage the device. 

  

 

NOTE: 

Provides further information not concerning the safety of the device, the patient and the operator. 
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2. SAFETY-RELATED INFORMATION 
 

This chapter provides safety-related information the operator must become familiar with before using the device. 

 

To ensure the safety of the patient and of the operator, always follow the instructions provided herein, especially as 

far as functional tests, electric and mechanical safety and X-ray emission protection are concerned. 

 

In this respect, refer to this chapter, to Chap. 3 - “DEVICE SAFETY AND MAINTENANCE“ and to Chap. 6 - “SCAN“. 
 

 

WARNING: 

All operators must be familiar with the operative and environmental features of the device and 

know the procedures to be followed in case of hazard and for emergency switching off. 

 
 

 

 

2.1. APPLICABLE LAWS, JURISDICTION AND COURT OF JURISDICTION 
 

Strictly follow all requirements on device installation, maintenance and use. Refer to the local legislation if it is more 

severe than the prescriptions contained in this manual. 

 

For operators in Europe: any serious accident occurred in relation to the device must be reported to CEFLA s.c. and 

to the competent authority of the Member State where the user and/or patient lives. 

 
 

 

 

2.2. SYMBOLS ON THE DEVICE 
 

The following table describes the symbols indicated in the device labels: 
 

Symbol Standard Description 
 

 
IEC 60417-5010 On / Off (pressure-pressure) 

 

~ IEC 60417-5032 Alternating current 

 

 
ISO 7000-0434A Warning 

 

 
ISO 7010-W001 General warning sign 

 

 
ISO 7010-W012 Caution: hazardous voltage. 

 

 
IEC 60417-5019 Protective earthing system. 

 

N IEC 60445 Connection point of the neutral conductor of a permanently installed device. 

 

L IEC 60445 Connection point of the line conductor of a permanently installed device. 

 

 
IEC 60417-5841 Type B applied part protected against direct and indirect contacts. 

 

 
IEC 60878-5909 Ionising radiations. 
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Directive 

2012/19/EU 
Disposal of WEEE (Waste Electrical And Electronic Equipment) 

 

 
0051 

(EU) Regulation 

2017/745  
CE marking. 

 

 
EN 980:2008 Serial number. 

 

 
EN 980:2008 Date of manufacture. 

 

 
EN 980:2008 Manufacturer. 

 

 
ISO 7000-1641 Operating instructions. 

 

 
ISO 7010-M002 Refer to the instruction manual. 

 

 
- Mark of conformity with technical regulations of Ukraine. 

 

 
ISO 7000-3500 The operator’s manual is provided in electronic format. 

 

 
ISO 15223-1 Medical device. 

 

 
ISO 15223-1 Model number. 

 

 
ISO 15223-1 Unique device identifier. 

 

 
IEC 60417-5638 Emergency stop. 

 

 

Original symbol required 

by IEC 60601-1 par. 9 

Head collision hazard. 

In order to avoid any collision, please refer to the Par. 6.1.2 - "Positioning 

the Patient and Starting the Scanning" for the correct positioning of the 

patient. 
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2.3. DEVICE SWITCHING ON AND OFF 
 

The device must be switched on and off as specified in the procedures indicated in par. 4.8 and 4.9. 

 
 

2.4. EMERGENCY SWITCHING OFF 
 

The device is provided with 3 emergency switch-off buttons. One is located on the front panel, near the motor-driven 

chinrest system, the second one near the main switch on the control box and the third one on the operator table. 

 

  
 

 
1- Device emergency buttons. 

 

If the device is shut down through an emergency stop button emission is immediately stopped and all device 

motorised movement functions are disabled. 
 

 

WARNING: 

The emergency switching off must be used exclusively in case of hazardous situations, i.e.: 
 

• The X-ray source does not stop the emission. 
 

• Situations that can injure people, harm the environment or damage the device. 
 

• Conditions where the device indicates an emergency situation. 
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2.5. SAFETY OF PATIENT AND OPERATOR 
 

Work following the correct procedures and position the patient correctly to avoid risks for the patient and the involved 

operators. 

Pay special care in case of debilitated people or with traumas. 

 
 

2.5.1. PATIENT POSITIONING 

 

Make sure the patient is correctly positioned in the scanning area, with the head on the chinrest and that no other 

part of the body can touch the device or risk to be squeezed during the positioning and the examination. 

 

Make sure that patient's clothes and hair can not remain entangled. 

 

Perform the same check for any catheters, breathing tubes or ECG (Electrocardiography) cables. 

Before starting any device movement check that the patient is in the correct position and that there are not obstacles 

to the device movements. 

 

Refer to par. 6.1.3 - "Positioning the patient and starting the scanning" and to the attached document “General 

guidelines for use of the protocols of New Tom VGi evo”. 
 

 

 

2.5.2. DURING THE SCANNING 
 

During the device movement and the patient scanning process NEVER leave the device without a supervisor.  

 

Always keep the patient monitored for the entire scanning duration. 
 

 

WARNING: 

NEVER use the device without the operator supervision. 

  

 

NOTE: 

Consider the implementation of an audio/video communication device between the operator and 

the patient in case the operator controls the device from a protected and remote area. 

 
 

 

 

2.5.3. PATIENT GOING OUT OF THE SCANNING AREA 
 

At the end of the examination or after the emergency button has been pressed, it is possible to allow the patient to 

leave the scanning area without waiting for the rotary arm to return to the initial position. 

 
 

2.6. ARTEFACTS AND SCANNING REPETITION 
 

A scanning process must be repeated ONLY if there are important artefacts on a patient's image or if the patient 

position has clearly changed during the scanning. 
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2.7. PROTECTION AGAINST IONIZING RADIATIONS 
 

 

 

 

WARNING: 

NewTom VGi evo is an X-ray device and as such it exposes patients and operators to the risk 

deriving from ionizing radiations.  

It must be used in compliance with the safety standards set forth by the radiological protection 

standard in force in the country of use. 
  

 

WARNING: 

NewTom VGi evo must not be used for routine or screening examinations. For such purposes, 

consider other diagnostic equipment.  

The imaging examinations performed on each patient must be justified in order to prove that they 

provide more benefits than risks. 
  

Strictly follow the applicable radiological protection standards and any prescription provided by a Qualified Expert. 

 

Operator 
 

The operator must follow the examination from a control work station according to the prevailing laws; nobody is 

allowed to remain near the patient during the examination. 
 

 

WARNING: 

Never remain near the device during the emission. 

 

WARNING: 

Based on the recommended dose limits in the local country, please refer to the "Stray Radiation 

Map" to determine the minimum distance to maintain during X-ray emission. 

In case of the operator needs to remain in the room during the examination (e.g. in case of a 

patient panic reaction), shall wear suitable lead protection clothes and equipment as defined by 

the national and local standard1. 

 

Patient 
 

The user is responsible for protecting the patient from useless exposure. 
 

 

WARNING: 

Consider the use of a leaded apron to protect the patient from diffuse radiation. 

 

 

WARNING: 

When prescribing X-ray examinations to pregnant women or women that could be pregnant, 

carefully consider the possible radiation consequences on the fetus. When possible, avoid 

radiation to a fetus. 
 

 

WARNING: 

Consider the possibility to use a leaded apron with collar for thyroid to protect the patient from 

diffuse radiation. 
 

 

WARNING: 

Possible negative interaction of CT x-rays with implantable active and worn active medical 

devices.  

Contact the manufacturer of such devices for further information. 

 

 

 

 

 

 

 

 

 

 

 
1 e.g. Health Canada “Radiation Protection in Radiology – Large Facilities”, par. “Protective Equipment” 
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Emission view devices 
 

The emission status is clearly identified by: 

1. A signal on the display as shown below. Such signal is displayed only after the X-ray emission is started by 

pressing START on the keyboard or using a mouse (refer to chap. 6 “Scan”) and remains visible for the whole 

scan duration. 

 

 
 

2. A signal on operator console as shown below. Such signal is displayed on the operator console only after the X-

ray emission is started by pressing START on the keyboard or using a mouse (refer to chap. 6 “Scan”) and 

remains visible for the whole scan and/or emission duration. 

 

 
 

 

WARNING: 

If the emission signals are active when the X-ray emission command has not been given, if they 

are not active when the emission has been started or if the emission is not interrupted at the end 

of the preset time, turn off the system and contact the technical service. 

 

 
 

2.8. PROTECTION AGAINST LASER RADIATIONS 
 

 

The device is provided with a double laser to correctly position the 

patient. The laser radiation comes out of two holes on the front cover. 

 

The vertical line indicates the central sagittal plane of the 

reconstituted volume. The horizontal line indicates the central axial 

plane of the reconstituted volume. 

 

 

WARNING: 

Do not stare at the laser ray, do not look at it directly with optical instruments and avoid the direct 

exposure. The ray can cause permanent eye damage. 
 

 

WARNING: 

Keep a distance of at least 40 cm between the eyes and the laser emission point when the laser 

ray is active. 

If necessary consider the use of suitable protection goggles. 
 

 

WARNING: 

Failure to comply with the prescriptions and procedures described herein may lead to a 

dangerous exposure to radiations. 
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2.9. DEVICES CONNECTED TO THE CONTROL CONSOLE 
 

 

 

Any computer, monitor, printer, mouse, keyboard and any other device connected to the device control workstation 

MUST be compliant with the ISO and/or IEC and/or EN and/or local standards. 

Moreover, the workstation must be compliant with the IEC 60950-1 standard. 

 

For further information contact the Manufacturer. 

 

 

NOTE: 

The Manufacturer is not responsible for problems and/or malfunctions of parts and/or components 

not approved by itself and not installed by qualified technical personnel acknowledged by the 

manufacturer. 
 

Never eat/drink or leave beverage/food near the device and the console. 
 

 

2.10. MAINTENANCE INTERVAL 
 

Make sure that the maintenance operations described in par. 3.4 - “Device maintenance" are carried out. 

 
 

2.11. APPLIED PARTS 
 

 

 

The parts of the equipment that, during standard use, necessarily come into contact with the patient, so that the 

device may carry out its functions correctly, are: chinrest, bite and hygienic covers, headrest, handles, nose support. 

 

Parts not applied that might come into contact with the patient are the external covers and the chinrest structure. 
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3. DEVICE SAFETY AND MAINTENANCE 
 

This chapter includes information on device and environment safety. It also provides general information and 

procedures concerning the device maintenance. 

 

The user is responsible for a correct use of the device, in compliance with the instructions and procedures provided 

in this manual. In particular, the operator must observe the following instructions: 

 

• The device can be used exclusively by authorised personnel, trained on the machine use and the protection from 

radiations. Said personnel must also know the standards that regulate the use of X-ray devices. 

 

• The device must never be used in case of evident electric, mechanic or radiological malfunctions. In particular, it 

must never be used if the warning or emergency switch-off devices do not work properly. 

 

 
 

 

 

3.1. INSTALLATION REQUIREMENTS 
 

The device must be used in spaces intended for medical use in accordance with the recommendations of a Qualified 

Expert Operator. 

 

The equipment must never be exposed to acids, corrosive agents, salt and rain. 

 

Operating temperature: from +10° to +35° (Celsius) 

Operating humidity conditions: min 10%, max 85% (non-condensing) 

Altitude: ≤ 3000 m 

Pressure: 710 – 1060 hPa 

Pollution degree:  2 

CTI (“comparative tracking index”): IIIb 

 

Minimum dimension requirements of the installation room: 2 x 2.5 x 2.5 m. 

The equipment must be installed on a horizontal surface. 

In case of use with seated patient, make sure that the chair backrest is not higher than 75 cm. 

 

The supply line must be arranged according to the prevailing laws and to the instructions provided in the "Service 

Manual". 

 

Do not use temporary electric connections like reduction units, extensions, multiple sockets for the connection to the 

PC network or to other peripheral devices. 

 

The equipment must be connected to the electric system in a permanent way according to the prescriptions provided 

in the "Service Manual". 

 

The medical environment in which the device is installed must be designed by an expert in ionizing radiation 

protection as set forth by the prevailing national and local laws. The prevailing national and local laws will define the 

rules to be followed to design the signals to be applied to the system. 
 

 

WARNING: 

Never move the device after the installation. Moving the device may damage property and be 

harmful to people and the environment. 

The device must be connected exclusively with peripheral units, computers and cables compliant 

with the manufacturer's specifications. 
 

 

WARNING: 

Make sure the device is connected to an electric line with protective earth. 

 

 

NOTE: 

The computer must be installed outside the patient area. 

The connectors connected to the computer cables must be used exclusively for the connection to 

the computer.  

Such connectors must be handled by authorised and qualified personnel only. 
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3.2. SAFETY GUIDELINES 
 

The device is not protected against liquid and spray penetration. The penetration of liquids can damage the electric 

and electronic components and generate hazardous situations for the patient, the operator and the environment. 

 

The device safety systems do not reduce the fire-fighting protections installed in the room where the device is used. 

 

• Electrostatic discharges 

Electrostatic discharges can damage the machine electronic components. As a consequence, the floor of the room in 

which the device is installed should be made of antistatic materials. 

 

• Fire-extinguishers 

CO2 fire-extinguishers should be installed in an area easy to be reached. 

 

• X-ray warning lamp 

The user has the possibility to install an X-ray warning lamp to be used to know both if the X-ray source is ready and 

if the X-ray emission is active. 

 

• Switches on doors 

The user has the possibility to install an external switch to stop the emission (usually installed on access doors of the 

room where the device is used). 

 

• Electromagnetic compatibility 

For information about the electromagnetic compatibility, refer to APPENDIX A - “Technical Specifications”. 

 
 

3.3. CYBERSECURITY INFORMATION 
 

Medical devices capable of connecting (eg. Ethernet port) to another device are vulnerable to cybersecurity. 

The intended use of the device (generation of radiologic two-dimensional and three-dimensional images) limits for its 

nature the intended use environment (health care facility, medical facility, hospital, etc.) and the intended users 

(health care worker, pysician, etc). 

This condition limits the probability that the device may be subject to cyber-attack. 

 

In every case some precautions are recommended: 

 

- the scanner and the workstations must be used in a controlled access environment (e.g. radiology department) so 

that they are accessible to authorised personnel only; 

 

- the workstations must belong to a medical network, where the cybersecurity countermeasures are correctly and 

effectively implemented in accordance with national and regional regulations in force; 

 

- the infrastructure must manage functions for access protection, therefore a login must be executed to access the 

workstation with correct User Id and Password. The passwords must be maintained reserved, not easily 

identifiable and they must be changed periodically; 

 

- the infrastructure must provide the protection from unauthorised accesses with firewall; 

 

- the infrastructure must manage functions for data protection; 

 

- the infrastructure must manage functions for logging and detecting accesses. 
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3.4. CHANGES TO THE DEVICE 
 

Any modifications or updates of the device must comply with the applicable legislation. 
 

 

WARNING: 

It is forbidden to open or tamper with the device with any tool. 

Any non-authorised change to the device (hardware and software) is forbidden and may 

compromise the correct device operation, cause breakages and/or accidents with consequent 

possible damage to the patient, the operator and the device. 

 
 

 

 

3.4.1. LIMITS OF RESPONSIBILITY 
 

The manufacturer is not responsible for the safety, reliability and performance features in the following cases: 

 

• The installation, maintenance and any change, repair and/or update are not performed by personnel authorised 

by the manufacturer or the distributor. 

 

• The spare parts have not been approved by the manufacturer or the distributor. 

 

• The environment conditions are not compliant with the requirements described in this manual, the requirements 

of the applicable laws and the recommendations of a qualified expert. 

 

• The device is not used as described in this manual. 

 
 

3.5. DEVICE MAINTENANCE 
 

 

 

Any change or update of the device must be compliant with the applicable laws. 
 

 

WARNING: 

Always turn off the device before performing any maintenance operation! 

 

 

WARNING: 

None of the internal parts of the equipment can be repaired. Never remove the equipment covers. 

 

 

WARNING: 

The only part that can be repaired by the user is the device input fuse, located near the switch-on 

panel, on the control box side. 

The spare fuse must be compliant with the manufacturer's specifications. 
 

 

WARNING: 

To ensure the protection against fire, replace only fuses with others of the same type and range. 

 

• Ordinary maintenance 

The ordinary maintenance is required to ensure the correct device operation as well as the safety of the patient, 

the operator and of third parties. 

 

 The device must be exclusively repaired and maintained by personnel authorised directly by the manufacturer or 

the distributor. All device components must be checked and replaced, if necessary, by qualified personnel. 
 

 

WARNING: 

If NewTom VGi evo device has not been used for scanning patients for a period longer than three 

months, carry out the x-ray source formation process (for more details, refer to the technical 

support). 

 

• Hazardous cleaning agents 

 Some cleaning agents should be avoided to prevent negative consequences on the device and people (see "3.5. 

Cleaning and disinfecting"). 

 

• Preventive maintenance 
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 Check the computer-scanner interface cables, the control computer-box and the relevant power supply cables at 

regular intervals. Check the connection cable to the computer, the monitor, the keyboard, the mouse and the 

printer according to the manufacturer instructions. 

 

• Component storage 

 Components must be stored and handled with care. 

 Any provided components must be stored and handled in compliance with the relevant technical specifications. 

 

• Malfunctions 

 In case the device does not work as described in this manual, contact the technical service immediately. 

 

• Maintenance contract 

 The device should be checked at regular intervals: contact the manufacturer or the distributor to discuss about a 

maintenance contract. 

 

• Check-list of the device checks 

 The following check-list indicates the recommended time intervals of the various device checks. 

 For further information contact your local distributor. 

 

Manager Component Activity Time interval 
    

Routing testing 

User Global device QA Phantom check Weekly 

Local Support Service Error log Check 12 months 

Every external part Damage check 12 months 

Emergency buttons Emergency test 12 months 

Electrical functioning Check 12 months 

Mechanical functioning Check 12 months 

Other test depending on local regulations 

Radioprotection expert 

or other qualified 

person depending on 

local regulations 

Global device Radiological test 

conforming to the local  

regulation concerning X-

ray medical electrical 

equipment.  

This tests in not in 

charge by user or local 

support service but may 

be established by local 

regulations. 

Radiological test 

conforming to the local 

standard 
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3.6. CLEANING AND DISINFECTION 
 

 

WARNING: 

Always turn off the device before performing any cleaning operation 

 

 

 

WARNING: 

Cleaning is the first step of any disinfecting process. Physically scrubbing with detergents and 

surface-active substances and rinsing with water removes a considerable amount of micro-

organisms. If a surface is not clean first, the disinfecting process cannot be successful. 

 

If a surface cannot be adequately cleaned, it should be covered with barriers. 

 

The outer parts of the equipment must be cleaned and disinfected using a product for hospital use with indications for 

HIV, HBV and tubercolocide (medium-level disinfectant) specific for small surfaces. 

 

The various drugs and chemical products used in dental surgeries may damage the painted surfaces and the plastic 

parts. Researches and tests performed show that the surfaces cannot be fully protected against the harsh action of 

all products available on the market. We therefore recommend protecting with barriers whenever possible. 

 

The harsh actions of chemical products also depend on the amount of time they are left on the surfaces. It is 

therefore important not to leave the product on the surfaces longer than the time specified by the manufacturer. 

We recommend to use a specially formulated medium-level disinfectant, STER 1 PLUS (CEFLA S.C.), which is 

compatible with coated surfaces, plastic parts and uncoated metal surfaces. As an alternative, we recommend to use 

products containing: 

- 96% ethanol. Concentration: maximum 30 g per 100 g of disinfectant. 

- 1-Propanol (n-propanol, propyl alcohol, n-propyl alcohol). Concentration: maximum 20 g per 100 g of disinfectant. 

- Combination of ethanol and propanol. Concentration: the combination of the two should be maximum 40 g per 

100 g of disinfectant. 
 

 

WARNING: 

- Do not use products containing isopropyl alcohol (2-propanol, iso-propanol). 

- Do not use products containing sodium hypochlorite (bleach). 

- Do not use products containing phenols. 

- All products must be used as directed by the manufacturer. 

- Do not mix the STER 1 PLUS disinfectant with other products. 

- Do not spray the selected products directly on the surfaces. 

 

 

Clean and disinfect with disposable non-abrasive paper (avoid 

using recycled paper) or sterile gauze. 

- Turn off the equipment prior to cleaning and disinfecting the 

external parts. 

- All materials used to clean and disinfect must be thrown 

away. 

 

- Computer and peripheral devices 

 Follow the manufacturer's instructions to clean the computer and the peripheral devices. If such instructions are 

not available, refer to the instructions provided in the previous paragraph. 

 

 

NOTE: 

Contact the local distributor for further information about the device safety and maintenance. 

 
 

3.6.1. HYGIENE PROCEDURES FOR PATIENT PROTECTION 
 

Disposable hygienic protections are the main protection means against cross contamination between patients. In 

order to prevent the transmission of infectious diseases between patients, it is essential to always use disposable 
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protections. Disposable protections are class I medical equipment and cannot be replaced with other protections 

having lower specifications. 

Disposable protections must comply with standards ISO 10993-1 on biocompatibility and be approved by control 

bodies where required (e.g. FDA, CE). 
 

Always replace bite disposable hygienic protections before positioning a new patient. 
 

Disposable hygienic protections must be stored in a dry and clean area and must not be exposed to direct sunlight or 

UV radiation. 

Bite and chin rest can be disinfected by soaking them in a cold sterilising liquid. For sterilisation of such parts, follow 

the instructions provided by the sterilising product supplier. 

Cover with disposable protections all components that will be in contact with dental personnel's hands and might be 

contaminated by indirect contact with the mouth of the patient. In particular, pay attention while handling equipment 

control console, mouse and Personal Computer keyboard. 
 

Before positioning the patient for a radiological examination, always cover the bite with a new (non-sterile) plastic 

protection in order to prevent cross contamination. 
 

Note for Canada users: ask your dental distributor for hygienic protections with suitable size and marketed in Canada 

according to the local laws. 
 

In compliance with the provisions of Health Canada, bite protections are Class I equipment supplied by authorised 

distributors as per MDEL database. 

 
 

3.6.2. STERILISATION 
 

No sterilization is required for the standard use of the equipment. 

 
 

3.7. TRANSPORT AND STORAGE 
 

During the transport and the storage it is necessary to respect the conditions indicated below. 

 

Transport and storage temperature:  

from -20° to +70° (Celsius) 
 

Humidity conditions for transport and storage:  

min 10%, max 85% (non-condensing) 
 

Pressure: 

710 – 1060 hPa 

 

Do not expose to acids, salts, rain. 
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3.8. DEVICE DISPOSAL 

3.8.1. INFORMATION FOR DEVICE OWNER 
 

 

This symbol on the device indicates that it must not be disposed of together with other urban waste but it 

is necessary to collect it separately. 

 

The separate collection of this equipment is organised and managed by the manufacturer. When it is 

necessary to dispose of this equipment, contact the manufacturer and follow the device that the 

manufacturer has adopted to allow the equipment separate collection. 

 

The separate collection and recycling of the equipment to be scrapped, contribute to the preservation of 

the natural resources and ensure that such equipment is scrapped in respect of the environment and of 

the health. 

 

Illegal equipment disposal carries fines according to the local and regional laws. 

 

To dispose of computers and other peripheral devices, it is necessary to refer to the attached instructions provided by 

the manufacturer of the same devices. 

 
 

 

 

3.8.2. INFORMATION FOR COLLECTION / DISPOSAL / RECOVERY FACILITIES 
 

Separate the X-ray source, the electronic and mechanical parts, the plastic covers and the computer with the 

peripheral devices. 
 

The X-ray source contains oil that must be discharged to be disposed of and/or recovered. 
 

The plastic parts must be disposed of with approved methods. 
 

For all other parts for which the manufacturer does not provide specific information, refer to the national and local 

laws and the guidelines on hygiene, safety at work and environmental protection. 

 
 



 

 

 20   USER MANUAL  EN 

 

 

4. STARTING PROCEDURES 
 

 

This chapter provides an introduction to the NewTom VGi evo device, to the switch-on and switch-off procedures and 

to the control devices positioned on the scanner. 

 
 

4.1. INTRODUCTION TO THE DEVICE 

4.1.1. INTENDED USE 
 

 

The NewTom VGi evo device is a computerised tomograph that uses the "cone-beam" technology. 

It is intended for diagnostic purposes using geometric and radiological density information obtained from two-

dimensional and three-dimensional images of anatomical parts and objects in the area under investigation. 

 
 

4.1.2. INDICATIONS FOR USE 
 

 

The NewTom VGi evo is a computerised tomographic device using the cone-beam technology which acquires a 

sequence of images of the head, including ear, nose and throat (ENT), of dental and maxillofacial unit, teeth, lower 

and upper jaw, temporomandibular joint (TMJ), other areas of the human cranium and neck with sections of the 

cervical rachis for diagnostic use. 

The device carries out such operations reconstructing a 3D matrix of the examined volume and producing two-

dimensional views of the volume (tomographic sections, panoramic and cephalometric projections) and then displays 

two- or three-dimensional images. 

The device is managed and used by doctors, dentists, radiologists and other legally qualified professionals. 

 

Its use is intended on the whole patient population for which radiodiagnostic analyses are usually carried out, 

according to intended use, instructions for use, medical practice and local regulations. 

 

It can also be used for X-ray analyses on implants, surgical templates and other diagnosis auxiliary tools. 

 

Its use is intended in emergency situations, like first aid situations, only if a non-operation does not pose a hazard for 

the patient (e.g. if the centre is equipped with other equivalent equipment or a department of radiology). 

 

ONLY FOR CANADIAN MARKET 

The NewTom VGi evo is a computerised tomographic device using the cone-beam technology which acquires a 

sequence of images of the head, including ear, nose and throat (ENT), of dental and maxillofacial unit, teeth, lower 

and upper jaw, temporomandibular joint (TMJ), other areas of the human cranium and neck with sections of the 

cervical rachis for diagnostic use.  

The device carries out such operations reconstructing a 3D matrix of the examined volume and producing two-

dimensional views of the volume (tomographic sections, panoramic and cephalometric projections) and then displays 

two- or three-dimensional images. 

The device is managed and used by doctors, dentists, radiologists and other legally qualified professionals. 

 

Its use is intended on the whole patient population for which radiodiagnostic analyses are usually carried out, 

according to intended use, instructions for use, medical practice and local regulations. 

 

It can also be used for X-ray analyses on implants, surgical templates and other diagnosis auxiliary tools.  

 

Its use is intended in emergency situations, like first aid situations, only if a non-operation does not pose a hazard for 

the patient (e.g. if the centre is equipped with other equivalent equipment or a department of radiology). 

 

 

WARNING: 

It is recommended to use this device with patients more than 21 kg (46 lb) in weight and 

more than 113 cm (44.5 in) in height; these height and weight measurements 

approximately correspond to that of an average 5 year old child. 

The studies showed that paediatric patients can be more radiosensitive than adults (for 

example, the risk of cancer per unit of ionizing radiation dose is higher), therefore, it is 

necessary to pay special attention to the unnecessary exposure to radiation of paediatric 

patients. 
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WARNING: 

In particular for paediatric use, it is recommended to consult the general indications 

described in the existing guidelines for children imaging, e.g. those available in Image 

Gently (www.imagegently.org) website or in FDA website for "Pediatric X-ray imaging". 

 

 

WARNING: 

The NewTom VGi evo is able to produce panoramic reconstructions from CBCT 

acquisitions. This may reduce the dose if both CBCT and panoramic images are needed.  

However, if the device is used to simulate a panoramic X-ray image when a CBCT 

acquisition is not necessary, the patient could be exposed to an excessive dose of 

radiations. 

  

 

WARNING: 

The federal code limits the sale of this device only by or if prescribed by a doctor 

authorised by the law of the State in which he uses or prescribes the use of X-ray imaging 

systems 21CFR801.109 (b) 

 

 

WARNING: 

The imaging Cone Beam must not be used for routine (or "screening") examinations.  

Other diagnostic tools must be taken into consideration. The imaging examinations must 

be justified for each patient in order to prove that they provide more benefits than risks. 

 

 

WARNING: 

Where it is likely that an evaluation of soft tissues will be required as part of the patient X-

ray evaluation, the appropriate imaging should follow the “Diagnostic Imaging Referral 
Guidelines of the Canadian Association of Radiologists”, instead of using the cone-beam 

technology. 

 

 

WARNING: 

When prescribing X-ray examinations to pregnant women or women that could be 

pregnant, bear in mind the possible radiation consequences on the foetus. 

Radiation on the foetus must be avoided as much as possible. 

 

 

Classification: 

Equipment classification according to the rules set out in Annex VIII of (EU) Regulation 2017/745: CLASS IIB. 
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4.1.3. IMPROPER USE 

The NewTom VGi evo device has not been designed for the following uses and/or applications (reasonably 

foreseeable improper use):  

 

- use with patients that cannot stand still during the entire scanning cycle (30 seconds max.); 

- use in anatomic regions that are not within the scope of the device intended use (e.g., chest and abdomen); 

- use for studying cerebral soft tissues;  

- use by staff that have not received training on the device;  

- use by staff that do not meet the requirements specified in the user profile;  

- use in the operating theatre;  

- use with removable metal objects (eye glasses, jewels, rings, necklaces) in the scanning field;  

- use in environmental conditions other than the indicated ones. 

 

 

 

 

4.1.4. FUNCTIONING 
 

The patient is approached to the chinrest structure and positioned correctly with 2 laser and "scout-view" image 

modules.  

 

The acquisition device performs a complete rotation around the patient's head and acquires X-ray images that are 

then automatically processed by the device.  

 

The result of such operation will be the sequence of axial slices that form the reconstituted volume. 

At the end of this process, the slices will form the Volumetric Data. These data allow viewing coronal and sagittal 

sections of the area reconstructed in real time. 

 

Starting from the volumetric data and through the definition of a Region Of Interest (ROI), the user starts the 

examination. The ROIs can be inclined with respect to the volumetric data both to obtain orthogonal images, e.g. at 

the mandible plane, and to correct positioning errors. 

 

Working on the acquired data, it is possible to create panoramic and transaxial sections and tridimensional 

reconstructions. Then it is possible to work on these images to trace distances, angles, add comments etc. 

At the end, the new images are saved in the examination section. 

 

The examination images can be used to write a report that can be printed and/or saved on electronic support. 

 

For further information, refer to the "NNT User Manual". 
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4.2. OPERATION PRINCIPLE 
 

In the "Cone-Beam" technique, the tube-detector device (conical X-ray beam and two-dimensional detector) performs 

a single rotation around the patient, simultaneously acquiring all the data necessary for volumetric reconstruction.  

In other words, the data acquired at each scanning step are the digital images corresponding to the relevant 

radiographic projection, and all collected data (also called "raw data") are then used in the volumetric reconstruction 

process. 

 

Following are the advantages of this technology compared to the standard systems: 
 

• Direct reconstruction of all scanned points, without going through the axial reconstructions and the data 

reformatting; 
 

• Total scanning speed usually higher since it is linked with the acquisition electronics rather than with the power of 

the radiogenic tube and the mechanical sophistication; 
 

• At the same scanning duration: fewer requirements in terms of generator/tube assembly power and scanning 

mechanic, with consequent structural and maintenance advantages. 

 
 

 

 

4.3. OVERVIEW 
 

The device consists of three components: the scanner, the control box and the main workstation, installed outside the 

patient area. 

 

The main workstation can be provided with other computers to process and store data.  

 

For further information, refer to the “NNT User Manual”. 

 

 
1. Scanner 

2. Control box 

3. Workstation 
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4.4. SCANNER 

4.4.1. OPERATOR CONSOLE AND CONTROLS  
 

The scanner represents the device central unit.  

On the lateral supports (on the right or left side, as required) there is the operator console that allows moving the 

device and turning on the warning lamp that indicates the device switching on and the X-ray emission in progress. 
 

Following is a short description of each button on the device remote control: 
 

 
S Scanner movement selection button:  

 it enables the button operation for the vertical movement and the arm rotation of the scanner. 
 

P1 Chinrest x-y movement selection button:  

 it enables the button operation for the chinrest device horizontal movement (right / left) and the vertical 

movement (up / down). 
 

P2 Chinrest transversal movement selection button:  

 it enables the button operation for the chinrest device transversal movement (depth). 
 

L Laser button: 

 to be pressed to switch on/off the positioning laser. After 60 seconds the laser switches off automatically. 
 

M Menu selection button: 

 it allows entering the information or service menu. 
 

E Confirmation button: 

it allows confirming the items selected in the menus. 
 

B Back button 

 it allows cancelling the confirmation of the items selected in the menus 
 

F1/ F2/ F3/ F4 Movement buttons: 

 they allow moving the previously selected device in the desired direction (through buttons S, P1 or P2). 

 They allow scrolling through the menu items. 
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4.4.2. SCANNER MOVEMENT  
 

 

After pressing the S button (Scanner movement 

selection button) the console screen will display the 

scanner image. 

 

Press the F1 / F2 arrows to move the unit up/down or 

F3 / F4 arrows to rotate the arm clockwise or counter-

clockwise. 

 

 

4.4.3. CHINREST DEVICE MOVEMENT 
 

 

After pressing the P1 button (Chinrest x-y movement 

selection button) the console screen will show the 

front view of a patient positioned on the chinrest 

device. 

 

Press the F1 / F2 arrows to move the chinrest device 

up/down or F3 / F4 arrow to move the device to the 

right/left. 
 

 

After pressing the P2 button (Chinrest transversal 

movement selection button) the console screen will 

show the lateral view of a patient positioned on the 

chinrest device. 

 

Press the F1 / F2 arrows to move the chinrest device 

up/down or F3 / F4 arrow to move the device 

transversally. 

 
 

 

 

4.4.4. INFORMATION MENU  
 

 

After pressing the M button (Menu selection button) 

the console screen will show the selection image of 

the information or service menu. 

 

By pressing the F3 / F4 arrows it is possible to 

position the selection red cursor under the information 

menu (marked by letter “i”) and confirm with button E 

(Confirmation button). 
 

 

The following information will be shown: 

 

- Device serial number 

- Console firmware version 

- Console icon version 

- Console position with respect to the patient 

 

To quit the menu, press button B (Back button). 
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4.4.5. SERVICE MENU  
 

 

After pressing the M button (Menu selection button) 

the console screen will show the selection image of 

the information or service menu. 

 

By pressing the F3 / F4 arrows it is possible to 

position the selection red cursor under the service 

menu (marked by a spanner) and confirm with button 

E (Confirmation button). 

 

For further information on the service menu functions, 

refer to the "Service Manual". 
 

 

4.4.6. OTHER FUNCTIONS  
 

According to the button pressed or the occurred events, the following icons will be displayed on the console screen: 
 

 

1) Laser activation icon 

 By pressing the L button (laser button), the device 

laser rays are activated and the relevant icon is 

displayed on the upper right corner of the screen. 

 By pressing the button again, the laser rays are 

deactivated and the icon will disappear from the 

screen. 

 

2) Emergency stop button activation icon 

 By pressing any device emergency button (both 

on-board the machine or separated from the 

machine), the relevant icon will appear on the 

lower right corner of the screen and the device 

functions will be disabled. 

 By releasing the emergency button, the device 

functions will be available again and the 

emergency icon will disappear from the screen. 

 

3) “Open door” warning icon 

 If the "open door" warning function is available, in 

case of door open, the relevant icon will be 

displayed on the lower left corner of the screen. 
 

 

4) “X-ray ready” icon 

 When the device is "ready" to emit X-rays, the 

relevant icon will be displayed on the upper left 

corner of the screen. 

 Moreover, the console screens will change colour, 

from white to green. 
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4.4.7. X-RAY EMISSION  
 

 

During the scanning process (when the device emits 

X-rays), the screen will show a page with a grey 

background and a yellow emission symbol. 

At the end of the emission, this page will automatically 

disappear. 

 
 

 

 

4.5. CONTROL BOX  

4.5.1. MAIN SWITCH  
 

The control box contains the electronic instruments that manage the device operation. 

On the outer surface there is the switch that allows switching on/off the device, and the relevant fuse holder is located 

near the switch. 
 

 
1 Emergency switch-off 

2 Device main switch 

3 Input fuse holder 

 
 

 

 

4.5.2. INPUT PANEL  
 

On the main switch opposite side there is the panel with the equipment supply and control cables and the connectors 

for the connection to the main workstation through CAN Bus as well as for the connection of the X-ray emission 

button. 
 

 
1 Optional output for the door switch 

2 CAN bus connector for workstation 

3 X-ray emission button connector 

4 Outlet of control box - scanner connection cables 

5 External power supply input 

6 Optional output for external lamp 

7 Output for table emergency button. 
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4.6. STANDARD COMPONENTS  
 

The device is equipped with some standard components. The main ones are listed below, refer to the local dealer for 

the full list of available components. 
 

 

Craniostat:  

Fixed to the scanner mechanical structure, it allows 

the correct positioning of the patient and avoids 

excessive movements of the patient during the 

examination. 

 

 

Chinrest: 

Used to position the patient's chin. 

It is inserted in the craniostat. 

 

 

Undernose support 

Used to position the patient's nose. 

It is inserted in the craniostat. 

 

 

Bite 

Used to stabilise the patient's mouth (bite). 

It is inserted in the craniostat. 
 

 

Calibration support:  

Used as bearing surface for the Phantom QA 

examination.  

It is used as an alternative of the craniostat. 

 

 

Prosthesis support:  

It is used as a bearing surface for dental prosthesis on 

the scanning unit. 

It is inserted in the craniostat. 

 

 

Phantom QA:  

Used to perform the quality control procedure. 

Used with the Calibration support. 
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4.6.1. X-RAY EMISSION REMOTE CONTROL 
 

The device is provided with a remote control to enable the X-ray emission, in compliance with the IEC60601-2-63 

standard requirements. 

For its use, refer to the safety standards set forth by the radiological protection standards in force in the country of 

use. 
 

The remote control features: 
 

 

1 A button to confirm the X-ray emission 

 

2. Two luminous LEDs: 

 Green (machine ready for the emission) 

 Yellow (X-ray emission in progress) 

 

When the device switches to the "Ready" status, it is possible to enable the X-ray emission (green LED steady-on) by 

pressing the remote control button and keeping it pressed for the entire duration of the X-ray emission. 
 

When the device requires a specific button to be pressed to enable the X-ray emission, an intermittent sound will be 

activated 
 

The examination is in progress when the yellow LED is activated on the remote control and at the same time a 

continuous acoustic signal is activated. 
 

  

Button pressed Button released 

 

 

WARNING: 

If the button is released before the examination is completed, the image acquisition will be 

interrupted. 
 

In compliance with the local laws, the operator must be provided with suitable protection equipment and protected 

against ionizing radiations during the emission. For further details, refer to the notes provided in Chap. 2. 
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4.7. CABLES  
 

The device is provided with cables for the connection of workstation/scanner and workstation/control box. I.e.: 
 

 

• Ethernet cable (4 pairs/26 AWG-FTP-Category 6) 

(Workstation / Scanner) 

• CAN bus cable (2 pairs/24 AWG shielded) 

(Workstation / Control box) 

 

In addition, there is a cable branch for the control of the scanner at the control box outlet. 

The manufacturer provides the supply cable with an end directly connected to the device. The user shall connect the 

device to the electrical mains during the installation. 
 

 

WARNING: 

Using components, transducers and cables other than those specified may result in degradation 

of the electromagnetic compatibility characteristics of the device! 

 
 

 

 

4.8. SWITCHING ON THE DEVICE  
 

Following is a description of the procedure to correctly switch on the device: 
 

1. Switch on the scanner through the main switch located on the control box input panel. 

2. Switch on the workstation. 

3. Wait for the workstation to load the operative system. 

4. Log in the operative system with username and password. 

5. Launch the NNT application. 
 

 

NOTE: 

First switch on the device. If you try to use the application before the device has been initialised, 

the connection will be denied. 

 
 

 

 

4.9. DEVICE SWITCHING OFF  
 

Following is the description of the correct device switching off procedure: 
 

1. Close the NNT software. 

 

2. Stop the operative system and wait for the workstation to switch off. 

 

3. Switch off the device through the suitable main switch located on the control box input panel. 
 

 

WARNING: 

Switch off the device in case it is not used for more than 3 hours. 

 

 

WARNING: 

Always switch off the device at the end of the work day. 
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5. PRELIMINARY OPERATIONS 
 

• "Daily check"; 

• Blank image acquisition ("Blank acquisition"); 

 

This chapter describes the required and/or useful functions: 
 

• Beam limiter test 

• Rotary arm complete lowering 

 

The blank image must be acquired every 13 weeks, whereas it is compulsory to start the Daily check every day 

before starting patients' examinations.  

If such operations are not performed within the set intervals, the software will block the scanning function. 

 

The operation modes are described in the specific chapter in the "NNT User Manual". 
 

 

NOTE: 

If the environment temperature is too low or too high, it is recommended to bring it within the 

device operation range (+10 ÷ +35 °C) and wait a couple of hours to restore the thermal balance. 
 

 

5.1. DAILY CHECK  
 

Through the “Daily Check” the device checks that all components are working correctly. 

 

 

NNT starting page with request of Daily check. 

 

 

Before starting the procedure, make sure that the 

scanning area is completely empty. 

 

To this end, remove the chinrest structure. 

 

 

Daily check in progress. 
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5.2. BLANK ACQUISITION 
 

The Blank Acquisition allows optimising the scanning performance through the acquisition of a background image. 

 

This procedure is automatically performed by the software whenever necessary. 

 

 

Before starting the procedure, make sure that the 

scanning area is completely empty. 

 

For this purpose, if not previously carried out, remove the 

chinrest structure. 

 

 

The blank acquisition image will be as shown in the figure. 

It is extremely important to ensure that the image does not 

contain any unusual objects/shadows/marks. 

 

 

5.2.1. BLANK ACQUISITION INVALIDATION  
 

This function is only available for the main workstations. To invalidate the blank acquisition, follow the instructions 

below: 

 

 

From the NNT software, select “Scan” → “Invalidate 

Blank”. 

 

Upon next selection of the acquisition FOV, the NNT 

software will request the next Blank acquisition. 

 

 

 
 

 

WARNING: 

If the test has been performed correctly but has not been completed successfully, please contact 

our Technical Support.  
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5.3. BEAM LIMITER TEST  
 

From the main bar of the NNT software, select "Tools" → "Scanner Test".  

 

From the service window bar, select "Tools" → "Beam Limiter Test".  Select the desired FOV. 

 

Set the appropriate radiological parameters according to the selected FOV (standard: SFS, 1 mA, 10 msec, KV = 

110; HiRes standard: SFS, 6 mA, 10 msec, KV = 110). 

 

Start an acquisition. 

 

 

Check that the beam is limited within the indicated 

margins:  

 

- The green rectangle must be completely inside the 

acquired grey area. 
 

- The grey rectangle sides must pass through the drawn 

red line pairs. 

 

 

 
 

WARNING: 

If the grey image acquired is not correctly collimated within the red lines, please contact our 

Technical Support.  

 
 

 

5.4. LOWERING THE ROTATING ARM COMPLETELY  
 

This function is useful to fully lower the rotary arm. For instance, in case of mobile application, during the transport it 

is recommended to position the arm completely lowered. 
 

 

WARNING: 

Before using this function make sure that nothing obstacles the arm downward movement! 

 

To lower the rotary arm, follow the instruction below: 

 

1. From the main bar of the NNT software, select “Tools” → “Scanner Test”.  

2. From the service window bar select “Tools” → “Lift down the rotating arm”. 
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6. SCANNING 
 

This chapter describes the procedures to be followed for a correct positioning of the patient or of the prostheses and 

for a correct execution of the examination.  

The description of the scanning procedure is provided in the specific chapter of the document "Acquisition operations 

with NewTom VGi evo" attached to the "NNT User Manual". 

We also recommend referring to chapters 2-“Safety-related information" and 3 - "Device safety and maintenance”. 

 

It is possible to perform the scanning procedure as follows:  
 

• [24x19] (diameter volume 24cm, height 19cm); 

• [17x19] (diameter volume 17.5cm, height 19cm); 

• [16x16] (diameter volume 16cm, height 16cm); 

• [15x12] (diameter volume 15cm, height 12cm); 

• [15x5] (diameter volume 15cm, height 5cm); 

• [12x8] (diameter volume 12cm, height 8cm); 

• [10x10] (diameter volume 10cm, height 10cm); 

• [10x5] (diameter volume 10cm, height 5cm); 

• [8x8] (diameter volume 8cm, height 8cm); 

• [8x5] (diameter volume 8cm, height 5cm); 

• [5x5] (diameter volume 5cm, height 5cm); 

 

• [15x5] HiRes (High Resolution, diameter volume 15cm, height 5cm); 

• [12x8] HiRes (High Resolution, diameter volume 12cm, height 8cm); 

• [10x10] HiRes (High Resolution, diameter volume 10cm, height 10cm); 

• [10x5] HiRes (High Resolution, diameter volume 10cm, height 5cm); 

• [8x8] HiRes (High Resolution, diameter volume 8cm, height 8cm); 

• [8x5] HiRes (High Resolution, diameter volume 8cm, height 5cm); 

• [5x5] HiRes (High Resolution, diameter volume 5cm, height 5cm); 

 

 
 

 

WARNING: 

Use the field of view as small as necessary according to clinical needs. In general, for small or 

paediatric patients it is recommended to use smaller FOV.  

 

NOTE: 

Non-HiRes FOVs are characterized with scanning time from 15 s to 20 s and exposure time from 

0.9 s to 3.5 s. 

HiRes FOVs are indicated for exams where a better details of bone structures is preferred 

(respect non- HiRes FOVs): 

 

> scanning time (between 18 and 25 s) 

> exposure time (between 1.8 and 6.0 s) 

 

> exam dose 

(approx. between 2.4 and 7.3 times) (compared to non- HiRes Eco Scan) 
(approx. between 3.4 and 3.8 times) (compared to non- HiRes Regular Scan) 
(approx. between 3.0 and 4.7 times) (compared to non- HiRes Enhanced Scan) 

For each of the described modes 3 different scan options are available: 

 

• Regular Scan: default option for image quality, scanning (from 15 to 18 s) and exposure (from 1.8 to 4.3 s) 

times 

 

• Eco Scan: indicated for exams where a low dose to the patient is preferred 

 < exposure time (between 0.9 and 1.8s), 

 < exam dose (approx. between 0.2 and 0.7 times)   (compared to Regular Scan) 

 

• Enhanced Scan: indicated for exams where image quality is preferred 

 > scanning time (from 20 to 25 s) 

 > exposure time (from 3.5 to 6.0 s) 

 > exam dose (approx. between 1.2 and 2.3 times)   (compared to Regular Scan) 
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When performing a Regular or an Enhanced Scan, it is possible to choose one of the following options: 

- Standard Dose: default option; 

- Boosted Dose: this option offers better image quality at the expense of a greater dose (up to twice the dose 

respect Standard Dose scans with the same scanning and exposure time), is indicated for thick bone structures; 

 

 

WARNING: 

For pediatric patient2 (also called children and small size patients) it is recommended to use the 

lowest-dose mode available: ECO SCAN. 

 

WARNING: 

Selecting a HiRes / Enhanced Scan / Boosted Dose protocol will result in more than 9 times the 

dose compared to a non-HiRes / Regular Scan / Standard Dose protocol with the same FOV. 

Imaging examinations must always be justified to demonstrate that the benefits outweigh the 

risks. 

 

NOTE: 

The relative dose informations between different FOVs and protocols was determined on the 

basis of the dose values reported in the attached document “Dose declaration and acceptance 

test”, by taking into account the CTDI weighted values. 

 

 
2 “Paediatric patient” is the patients more than 21 kg (46 lb) in weight and more than 113 cm (44.5 in) in height; these height and weight 
measurements approximately correspond to that of an average 5-year-old child.
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To choose one of these modes, select the desired scanning mode (FOV) from the "Scan Manager" panel located at 
the bottom right of the NNT software main window: 
 

 

"Scan Manager" panel of the NNT software 

 

 

 

 

6.1. SCANNING A PATIENT 

6.1.1. PREPARING THE PATIENT  
 

The preparation of a patient for an examination is an important process that can contribute to the correct execution of 

the scanning and to obtain high-quality images.  

 

The purpose of such process is to make the patient feel at ease and relaxed before and during the exam. Following 

are some recommendations to reach such purpose. 

 

• Room preparation 

 Make sure that the scanner is clean and ready to scan the patient ("Daily check" and "Blank Acquisition" already 

performed). 

 

• Preparing the patient 

 Ask the patient to remove any metallic objects (earrings, necklaces), glasses or removable metallic prostheses. 

 

• Positioning the patient 

 After positioning the patient in the scanning area, adjust the scanner and the chinrest device so as to frame the 

concerned scanning area and ensure the patient’s head and neck are in an upright position.  

 

• Explaining the examination 

 Briefly explain the examination procedure to the patient, including the data entry, positioning and scanning 

processes. 

 

• Problematic patients 

 A special attention must be paid in case the patient is a child, an old person, a claustrophobe or another person 

with a psycho-physic disability. 

 

• Correct breathing 

 Ask the patient to breathe slowly during the examination (a slow and continuous breath helps to avoid 

swallowing). 

 

• Relaxing 

 Ask the patients to keep the dental arches closed without grinding their teeth. 

 

• Avoid delays 

 To have relatively reduced examination times, complete all preliminary procedures before starting the 

examination. 

 

• Oral instructions 

 Tell the patient any oral instructions that the operator may have to use during the scanning. 
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6.1.2. CRANIOSTAT USE  
 

 
Craniostat components: 

1 – Base 

2 – Rods 

3 – Chinrest 

4 – Bite piece 

5 – Bite piece block lever 

6 – Cross member 

7 – Front support 

8 – Arms 

9 – Anatomic arches 

10 – Arms block levers 

11 – Undenose support 
 

 

The craniostat consists of a lower part and an upper one, connected by two 

carbon rods (2). 

 

The lower part consists of a base (1) which is fitted in the chinrest seat with 

metal pins and that can be removed by simply pulling upwards. 

 

 

The chinrest (3) is fitted in the dedicated inserts in the base (1) by means of 

pins and can be removed simply by sliding it upwards. 

 

 

The bite piece (4) is fitted in the suitable hole of seat (1): once it is set at the 

desired height, pull the central lever (5) from the left (unlocking position  ) to 

the right (locking position  ) in order to centre it and lock it in place. 
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Please remember that, in order to remove it, it is necessary to take lever (5) to 

the unlocking position and to slide it out of its seat. 

 

The upper part consists of a cross member (6) that can slide vertically along 

the carbon rods (2). 

The cross member contains the front support (7) that slides inside its seat in 

order to adapt it to the patient’s anatomy. 
 

 

After having correctly positioned the patient’s head,: 

a - push front support (7), making the pad rest against the patient’s forehead,. 

The forehead’s pressure on the support will automatically stabilise it. 

b - rotate the arms (8) towards the patient’s temples, ensuring that the rubber 

blocks at the ends of arches (9) adhere to the head anatomy. 

c - rotate levers (10) downwards to ensure a correct locking. 

CAUTION:  

Turn down the levers up to the contact with the patient. Do not force the 

complete closure of the levers  
 

At the end of the exposure, rotate the levers upwards to unlock arms, thus allowing the patient to get out easily In 

examinations where the undernose support (11) is used, it should be fitted INSTEAD OF THE CHINREST in the 

inserts in the base and pushed FULLY DOWN INTO PLACE. 
 

6.1.3. POSITIONING THE PATIENT AND STARTING THE SCANNING 
 

 

 

Following is a description of the operations to be performed to position and centre the patient inside the scanning 

area. Perform these operations when prompted by the software. 
 

The guidelines for patient positioning during examination of the different anatomic regions are outlined in the 

attached document “General guidelines for use of the protocols of NewTom VGi evo”. 
 

 

WARNING: 

The scanning area where the patient is positioned must be free of objects since they could injure 

the patient and/or invalidate the examination results. 
 

 

WARNING: 

Pay attention during the patient movements since his/her head and shoulders could accidentally 

impact against the device if the patient is positioned in a wrong way. 
 

 

Bring the chinrest device to the default position (the three positioning 

rulers A, B, C must be set to the default position "0") through the special 

chinrest buttons on the console (refer to par. 4.4.1 - "Operator console 

and controls"). 
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Through the suitable buttons on the console, move the rotary arm 

structure up/down to allow the patient to easily access the scanning area 

(the chinrest should be approximately at patient's head height). 

 

Bring the patient near the chinrest without touching the structure. 

 

 

Switch on the positioning laser beams through the suitable button on the 

remote control. 

 

 

NOTE:  

Ask the patient to temporarily close his/her eyes 

before switching on the positioning laser beams. 

 

The laser vertical line indicates the centre of the scanning volume and 

corresponds to the patient's sagittal plane. 

In case of field scanning [24x19], the upper horizontal line indicates 

approximately the centre of the scanned volume. 

The lower horizontal line indicates (for all FOVs) the lower limit of the 

scanned volume. 
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Adjust the scanner height through the suitable buttons on the console to 

reach the area to be scanned with the laser lines. 

 

Adjust the chinrest device height so as to bring it to the patient's chin 

height. 

 

 

Adjust the craniostat height (as indicated in par. 6.1.2 - “Craniostat use”). 

 

 

Tell the patient to position in the craniostat recommending him/her to:  

 

- grab with his/her hands the handles on the chinrest structure; 

 

 

- bite the bite piece (ensuring to have previously inserted the 

disposable hygienic protection). 

 Adjust the bite so that the upper and lower incisor tips are in the 

suitable groove. The inter-incisor gap must be in the bite medium line. 

 

 

 

 

The bite correct positioning is made easy by the up/down sliding capacity 

of the relevant support stem. 

- Tighten the suitable handgrip to block the bite in the correct position. 

- Block the craniostat position (as indicated in par. 6.1.2 - “Craniostat 

use”). 

 

 

NOTE:  

If the patient is not in a natural position, it will be 

necessary to further adjust the scanner height. 
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It is necessary to make sure that the rotary arm does not impact the 

patient's shoulders or nape: slowly rotate the arm through the operator 

console. 

 

 

NOTE:  

The check described above must be carried out for 

each field of view, paying particular attention to the 

use of the smaller FOVs, since when using them the 

impact probability of the device with the patient is 

higher. 

 

Position the patient using the scout latero-lateral (LL) and anteroposterior 

(AP) images. 
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6.1.4. SPECIAL CONSIDERATIONS FOR CHILDREN AND SMALL PATIENTS 
 

 

 

NewTom VGi evo has been also designed for pediatric patient (also called children and small size patients) is the 

patients more than 21 kg (46 lb) in weight and more than 113 cm (44.5 in) in height; these height and weight 

measurements approximately correspond to that of an average 5-year-old child. 
 

It should be noted that all examinations using CBCT should be performed only when necessary to answer a medical 

question, treat a disease, or guide a procedure.  

X-ray exams should use scan protocols that assure the lowest radiation dose that yields an adequate image quality 

(i.e., radiation doses should be "As Low as Reasonably Achievable" (ALARA)). 
 

The clinical indication and patient medical history should be carefully considered before referring a patient for any X-

ray examination.  

Because children are more sensitive to radiation, they should have a CT study only if it is essential for making a 

diagnosis and should not have repeated CT studies unless absolutely necessary. 
 

NewTom VGi evo may be used for children or small patients, but according to the limitations above illustrated.  

The features available for this purpose are: 

 

• small fields of view, e.g. FOV: 5x5 cm, 8x8 cm, 10x10 cm; 

• ECO SCAN: a low-dose, fast protocol (15 s for Standard modality, 18 s for HiRes modality, ~ -30 % dose vs. a 

standard protocol); 

• automatic calculation of the minimum radiology parameters required for performing the examination, depending 

on the size and density of the volume to examine (SafeBeamTM); 

• the indication of the dose values set by the software before the actual scan of the patient; 

• the low scan time typical of the CBCT technology that helps provide fast examinations and decreases the chance 

of movement of the patient; 

• possibility to perform exams while the patient is seated, to provide greater comfort and calm for the patient. 

 

The head support tools provided for performing the examination are the same for adult and pediatric patients, as they 

can be adjusted and suited to the different patients' size. 
 

NewTom VGi evo is equipped with laser pointers and a special device that reads the 3D coordinates for the patient's 

support position, which helps the user to identify the best position for patients of different sizes before any radiation 

emission. 
 

Appropriate patient preparation is crucial for image quality. Any measure that can calm the child prior the start of 

imaging procedure will help keep the child quiet and still during the imaging study. 
 

The short scansion examination time (15 seconds for Eco Scan, Standard Modality) helps reduce the possibility of 

patient movements and increases the comfort. 

Patients who cannot remain still during the entire examination time represent an improper use of the machine, as 

outlined in this user manual. 
 

The guidelines for adult and pediatric patient positioning during examination of the different anatomic regions are 

outlined in the attached document “General guidelines for use of the protocols of NewTom VGi evo”. 
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6.1.5. RECOMMENDATIONS FOR EXAMS IN THE PRESENCE OF METAL RESTORATIONS  
 

In the case of metal restorations (particularly amalgam fillings), it is advisable to take certain precautions when 

performing the tomographic examination in order to reduce the artefacts that these metal objects can cause: streak 

artefacts when the beam passes through a single object, or beam starvation artefacts between two metal objects in 

close proximity. In these cases, it is advisable to: 
 

 

1. Position the patient by aligning the upper horizontal light trace with 

the Camper's plane (the plane between the centre of the external 

auditory canal and the anterior nasal spine); 

 

 

 

2. Select the “Regular” or “Eco” modes in the dose profile section to 

reduce x-ray emission; 

 

 

 

3. Activate the “MAR” metal artefact reduction algorithm using the 

appropriate button (refer to the document NNT - User Manual). This 

is an optional feature that can be activated when the minimum 

system requirements are met (for more details on minimum and 

recommended hardware and software requirements, refer to the 

annex “Minimum and recommended system requirements”). 
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6.2. CINEX SCAN  
 

It allows performing the CineX examination: serial x-ray that allows for the dynamic acquisition of a set sequence of 

X-ray images saved on a video. 
 

 

To start the CineX scanning procedure click the “Scan → 

CineX acquisition” button in the menu. 
 

This type of scanning involves only one pre-set view field. 

 

 

The warning window prompts the operator to reposition the 

patient arm to the default position. 

By pressing “OK” the patient arm will be moved automatically 

and returned to a default position. By pressing the “SKIP >>” 

button the repositioning procedure will be skipped. 

 

If from the last NNT software start-up the repositioning 

procedure has never been performed, a warning will be 

displayed. By pressing the “YES” key the operations will carry 

on, however it will not be possible to use the patient arm 

movement remote procedure until the reset is performed at 

least once from the last software start-up. 

 

 
 

6.2.1. POSITIONING THE PATIENT AND STARTING THE SCANNING 
 

 

Once the patient's data have been entered, a window for 

scanning parameters selection will be displayed. 

 

It is possible to choose between patient side and frontal / rear 

scanning. 

 

The duration of the exam is freely selectable in the range of 1 

- 36 seconds. If the exam lasts between 1 and 20 seconds, 

the scanning will be carried out by acquiring 20 frames per 

second; if it is between 21 and 36 seconds, the scan will be 

carried out by acquiring 15 frames per second. 

 

After selecting the acquisition time and pressing OK, scanning 

start will be initialised. 

 

For further information on patient positioning and preparation, 

please refer to Par. 6.1.2-6.1.3 

 

For the complete scanning procedure, refer to the Par. “CineX 

SCANNING OF A PATIENT” of the document “Acquisition 
operations with NewTom VGi evo” attached to the “NNT User 

Manual”. 
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6.3. SCANNING A PROSTHESIS 

6.3.1. PRELIMINARY OPERATIONS 

 
 

Enter the patient's prosthesis data (if not already present in the software database). For further information, refer to 

the “Acquisition Operations with NewTom VGi evo” annex to the “NNT User Manual” document. 
 

 

 

6.3.2. POSITIONING THE PROSTHESIS  
 

Following is a description of the operations to be performed to position and centre the prosthesis inside the scanning 

area. Perform these operations when prompted by the software. 
 

 

Remove the chinrest from the relevant structure and the bite. 
 

Insert the prosthesis support between the carbon bars (as indicated in the 

figure).  

Position the prosthesis to the chinrest so that it is in the position 

(direction) that it would have inside the patient's mouth. 
 

It is possible to obtain a better position of the prosthesis using the 

anteroposterior (AP) and latero-lateral (LL) scout images. 
 

Once the prosthesis is positioned, perform the scanning as described in 

the “Acquisition Operations with NewTom VGi evo” annex to the “NNT 

User Manual” document. 
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7. QUALITY CONTROL 
 

The quality control consists in the execution of the standard examination on a suitable phantom, through an 

automatic procedure. 
 

This control, that is recommended at least once a week, ensures the correct operation of the device and the validity 

of the obtained results. 
 

Before starting the phantom scan the acquisition area must be selected. 
 

The test procedure is described in the document “Acquisition operations with NewTom VGi evo” enclosed to the 

“NNT User Manual”. 

 
 

 

 

7.1. PHANTOM POSITIONING  
 

 

 

Following is a description of the operations to be performed to position and centre the phantom inside the scanning 

area. Perform these operations when prompted by the software. 
 

 

Remove the craniostat from the chinrest device. 

 

 

Insert the calibration support. 

 

 

Position the phantom on the support in the central position. 

 

To facilitate the correct positioning of the phantom, set the chinrest as 

described below using the relevant buttons on the console (refer to par. 

4.4.1 - Operator console and controls). 

 

Ruler A – B - C → "QA" position 

 

 
     1st scout view. 

The first displayed "scout view" image corresponds to the phantom view 

in the scanning initial position. 

 

Using this image it is possible to further centre the phantom 

perpendicular to the rotary arm.  

 

Repeat the operation until necessary (the aluminium cylinder should be 

between the vertical red broken lines, whereas the internal balls must be 

passed through by the horizontal red broken lines). 

 



 

 

 48   USER MANUAL  EN 

 

 
      2nd scout view. 

To centre the QA phantom from the front side use the second "scout 

view" obtained with the arm at 90 degrees. 

It is therefore possible to scan the phantom. 

 

For further details, refer to the “Acquisition Operations with NewTom VGi 

evo” annex to the “NNT User Manual” document. 

 
 

7.2. IMAGE EXAMPLES 
 

Following are some examples of images acquired during the phantom analysis: 
 

   

Lateral view. Axial section. Panoramic section. 

 
 

7.3. SAVING THE PHANTOM ANALYSES 
 

Each phantom analysis report is automatically saved by the software. Afterwards, the reports can be retrieved by 

selecting “View” → “QA Report”.  

Once opened, it is possible to scroll through the different reports using the PAGE DOWN, PAGE UP keys on the 

keyboard.  

It is possible to create copies of the QA Report in PDF format by selecting the “File” → “Save as PDF” menu. 
 

 

It is recommended to print and keep a paper copy of the Phantom QA analysis. 
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8. TROUBLESHOOTING 
 

To solve device problems, refer to the “NNT – Error Guide” document. 
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9. APPENDIX A: TECHNICAL SPECIFICATIONS  
 

 

Scanner 
 

Scanning device (cone beam 

technology) 
Single rotation and volumetric acquisition  

Scanning parameters 

Mode: 

 

Regular Scan: 

[24x19]: 
[17x19]: 
[16x16]: 

[15x12] 

[15 x 5]: 

[12x8]: 

[10x10]: 

[10x5]: 

[8x8]: 

[5x5]: 

[15x5] HiRes: 

[12x8] HiRes: 

[10x10] HiRes: 

[10x5] HiRes: 

[8x8] HiRes: 

[8x5] HiRes: 

[5x5] HiRes: 

 

ECO Scan: 

[24x19]: 
[17x19]: 
[16x16]: 

[15x12] 

[15 x 5]: 

[12x8]: 

[10x10]: 

[10x5]: 

[8x8]: 

[5x5]: 

[15x5] HiRes: 

[12x8] HiRes: 

[10x10] HiRes: 

[10x5] HiRes: 

[8x8] HiRes: 

[8x5] HiRes: 

[5x5] HiRes: 

 

Enhanced Scan: 

[24x19]: 
[17x19]: 
[16x16]: 

[15x12] 

[15 x 5]: 

[12x8]: 

[10x10]: 

[10x5]: 

[8x8]: 

[5x5]: 

[15x5] HiRes: 

[12x8] HiRes: 

[10x10] HiRes: 

[10x5] HiRes: 

Time / X-ray emission 

 

 

15 s / 1.8 s 

15 s / 1.8 s 

15 s / 1.8 s 

15 s / 1.8 s 

15 s / 1.8 s 

15 s / 1.8 s 

15 s / 1.8 s 

15 s / 1.8 s 

15 s / 1.8 s 

15 s / 1.8 s 

18 s / 4.3 s 

18 s / 4.3 s 

18 s / 4.3 s 

18 s / 4.3 s 

18 s / 4.3 s 

18 s / 4.3 s 

18 s / 4.3 s 

 

 

15 s / 1.2 s 

15 s / 1.2 s 

15 s / 1.2 s 

15 s / 1.2 s 

15 s / 1.2 s 

15 s / 1.2 s 

15 s / 1.2 s 

15 s / 1.2 s 

15 s / 1.2 s 

15 s / 0.9 s 

18 s / 1.8 s 

18 s / 1.8 s 

18 s / 1.8 s 

18 s / 1.8 s 

18 s / 1.8 s 

18 s / 1.8 s 

18 s / 1.8 s 

 

20 s / 3.5 s 

20 s / 3.5 s 

20 s / 3.5 s 

20 s / 3.5 s 

20 s / 3.5 s 

20 s / 3.5 s 

20 s / 3.5 s 

20 s / 3.5 s 

20 s / 3.5 s 

20 s / 3.5 s 

25 s / 6.0 s 

25 s / 6.0 s 

25 s / 6.0 s 

25 s / 6.0 s 

25 s / 6.0 s 
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Scanning device (cone beam 

technology) 
Single rotation and volumetric acquisition  

[8x8] HiRes: 

[8x5] HiRes: 

[5x5] HiRes: 

 

 

Sharp 2D 

 

CineX 

 

25 s / 6.0 s 

25 s / 6.0 s  

 

 

19.2 s / 2.4s 

 

1÷20s @ 20fps / 0.2÷4s 

21÷36s @ 15fps / 3.15÷5.4s 

Sampling angle 360° 

Patient positioning Fixed position 
Motor-driven chinrest device with 

laser targeting 
 

Analysed anatomic volume Cylinder 

[24x19]: 

Ø max 24 cm, h max 19 cm 

[17x19]: 

Ø max 17.5 cm, h max 19 cm 

[16 x 16]: 

Ø max 16 cm, h max 16 cm 

[15x12]: 

Ø max 15 cm, h max 12 cm 

[15 x 5]: 

Ø max 15 cm, h max 5 cm 

[12 x 8]: 

Ø max 12 cm, h max 8 cm 

[10 x 10]: 

Ø max 10 cm, h max 10 cm 

[10 x 5]: 

Ø max 10 cm, h max 5 cm 

[8 x 8]: 

Ø max 8 cm, h max 8 cm 

[8 x 5]: 

Ø max 8 cm, h max 5 cm 

[5 x 5]: 

Ø max 5 cm, h max 5 cm 

[15 x 5] HiRes: 

Ø max 15 cm, h max 5 cm 

[12x8] HiRes: 

Ø max 12 cm, h max 8 cm 

[10 x 10] HiRes: 

Ø max 10 cm, h max 10 cm 

[10 x 5] HiRes: 

Ø max 10 cm, h max 5 cm 

[8x8] HiRes: 

Ø max 8 cm, h max 8 cm 

[8 x 5] HiRes: 

Ø max 8 cm, h max 5 cm 

[5 x 5] HiRes: 

Ø max 5 cm, h max 5 cm 

Weight and size 

Scanner 

Width (diameter used during 

the scan) 
1284 mm 

Depth (max) 1752 mm 

Height 2330 mm 

Maximum weight 377 Kg / 831 lb 

Control Box 

Width 630 mm 

Depth 300 mm 

Height 970 mm 

Weight 95 Kg / 209 lb 
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Detector 
 

Image pixels 1560 x 1440 dots 

Pixel size 0,184 x 0,184  mm 

Pixel depth 16 bit 

S/N 
9.2 – 14.2 (standard resolution) 

17.1 – 21.3 (HiRes) 
dB 

Frame rate Max 30 F/s 

 

X-ray image scout view 
 

[24x19] 

Image pixels 720 x 780 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[17x19] 

Image pixels 570 x 780 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[16x16] 

Image pixels 540 x 678 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[15x12] 

Image pixels 518 x 512 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[15x5] 

Image pixels 518 x 216 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[12x8] 

Image pixels 454 x 342 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[10x10] 

Image pixels 410 x 428 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[10x5] 

Image pixels 410 x 216 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[8x8] 

Image pixels 340 x 342 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[8x5] 

Image pixels 340 x 216 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
 

[5x5] 

Image pixels 216 x 216 dots 

Pixel depth 16 bit 

Pixel size 0,368 x 0,368 mm 
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[15X5] HiRes 

Image pixels 1036 x 432 dots 

Pixel depth 16 bit 

Pixel size 0,184 x 0,184 mm 
 

[12X8] HiRes 

Image pixels 908 x 684 dots 

Pixel depth 16 bit 

Pixel size 0,184 x 0,184 mm 
 

[10X10] HiRes 

Image pixels 820 x 856 dots 

Pixel depth 16 bit 

Pixel size 0,184 x 0,184 mm 
 

[10X5] HiRes 

Image pixels 820 x 432 dots 

Pixel depth 16 bit 

Pixel size 0,184 x 0,184 mm 
 

[8X8] HiRes 

Image pixels 680 x 684 dots 

Pixel depth 16 bit 

Pixel size 0,184 x 0,184 mm 
 

[8X5] HiRes 

Image pixels 680 x 432 dots 

Pixel depth 16 bit 

Pixel size 0,184 x 0,184 mm 
 

[5x5] HiRes 

Image pixels 432 x 432 dots 

Pixel depth 16 bit 

Pixel size 0,184 x 0,184 mm 

 

Reconstructed volume 
 

[24x19] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø24 x H19 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 816 x 816 672 x 672 672 x 672 dots 

Pixel depth 16 bit 
 

[17x19] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø17.5 x H19 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 584 x 584 700 x 700 672 x 672 dots 

Pixel depth 16 bit 
 

[16x16] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø16 x H16 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 544 x 544 652 x 652 672 x 672 dots 

Pixel depth 16 bit 
 

[15x12] 

Shape Cylinder  

Reconstructed volume size Ø15 x H12 cm 
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(max) 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 515 x 512 614 x 614 764 x 764 dots 

Pixel depth 16 bit 
 

[15x5] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø15 x H5 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 510 x 510 612 x 612 764 x 764 dots 

Pixel depth 16 bit 
 

[12x8] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø12 x H8 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 410 x 410 492 x 492 614 x 614 dots 

Pixel depth 16 bit 
 

[10x10] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø10 x H10 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 344 x 344 412 x 412 516 x 516 dots 

Pixel depth 16 bit 
 

[10x5] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø10 x H5 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 344 x 344 412 x 412 516 x 516 dots 

Pixel depth 16 bit 
 

[8x8] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø8 x H8 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 276 x 276 330 x 330 414 x 414 dots 

Pixel depth 16 bit 
 

[8x5] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø8 x H5 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 276 x 276 330 x 330 414 x 414 dots 

Pixel depth 16 bit 
 

[5x5] 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø5 x H5 cm 

Voxel size 0,300 0,250 0,200 mm 

Image pixels 176 x 176 210 x 210 264 x 264 dots 

Pixel depth 16 bit 
 

[15X5] HiRes 

Shape Cylinder  
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Reconstructed volume size 

(max) 
Ø15 x H5 cm 

Voxel size 0,150 0,125 0,100 mm 

Image pixels 1020 x 1020 880 x 880 800 x 800 dots 

Pixel depth 16 bit 
 

[12X8] HiRes 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø12 x H8 cm 

Voxel size 0,150 0,125 0,100 mm 

Image pixels 820 x 820 700 x 700 672 x 672 dots 

Pixel depth 16 bit 
 

[10X10] HiRes 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø10 x H10 cm 

Voxel size 0,150 0,125 0,100 mm 

Image pixels 688 x 688 672 x 672 672 x 672 dots 

Pixel depth 16 bit 
 

[10X5] HiRes 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø10 x H5 cm 

Voxel size 0,150 0,125 0,100 mm 

Image pixels 688 x 688 824 x 824 800 x 800 dots 

Pixel depth 16 bit 
 

[8X8] HiRes 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø8 x H8 cm 

Voxel size 0,150 0,125 0,100 mm 

Image pixels 552 x 552 662 x 662 672 x 672 dots 

Pixel depth 16 bit 
 

[8X5] HiRes 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø8 x H5 cm 

Voxel size 0,150 0,125 0,100 mm 

Image pixels 552 x 552 662 x 662 828 x 828 dots 

Pixel depth 16 bit 
 

[5x5] HiRes 

Shape Cylinder  

Reconstructed volume size 

(max) 
Ø5 x H5 cm 

Voxel size 0,150 0,125 0,100 mm 

Image pixels 352 x 352 420 x 420 528 x 528 dots 

Pixel depth 16 bit 
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X-ray Parameters 
 

IAE X-RAY TUBE mod. RTM 30 HS 0.3/0.6 (rotary anode) 
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MONO-BLOCK 
 

Make IMD s.r.l. 

Model HF1 R 

X-ray tube IAE RTM 30 HS 0.3/0.6 (part no. XRM.11.X51.001 / IRM.11.280.001) 

Classification (IEC 60-601) Class I Type B 

PHYSICAL DATA 

Sheath material Aluminium 

Heat capacity 550 kJ 

Maximum continuous thermal dissipation 60 W at 110kV, 3.6 mA, 10 ms, 15 FPS 

Maximum temperature 60° 

Minimum inherent filtration at 70 kV 1.4 mm Al 

Oil volume compensation 410 cu. cm rubber chamber 

Dimensions 325 x 145 x 215 

Weight 19.5 kg 

ELECTRICAL DATA 

Maximum output voltage 120 kV 

Cathode-Ground 60 kV 

Anode-Ground 60 kV 

Maximum anode current at 110 kV 32 mA 

Maximum voltage at the tube at 32 mA 110 kV 

Maximum electric power 3.5 kW 

Maximum power ripple <1% 

High voltage increase time at maximum 

power 
<0.5 ms 

Cooling curve 

 
Rotor HF1R - Startup 230Vac / 0.8s / 10° - Running 60Vac / 2A 

Anode nominal rpm 3000 rpm / 10000 rpm 
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X-ray generator-tube-sheath assembly 
 

Mono-block Model HF1 R 

X-ray tube IAE RTM 30 HS 0.3/0.6 

Source-detector distance 721 mm 

Source-skin distance (minimum) 150 mm 

Total filtration 1.4 mm Al (Inherent filtration) + 10.6 mm Al (Supplementary filtration) 

Beam maximum dimension 238 mm x 179 mm (detector area) 

Voltage accuracy at the tube 3 < 10% 

Current accuracy at the tube 4 < 20% 

Radiation linearity 5 < 20% 

Emission time accuracy 6 < 5% + 50 ms 

Current-time product accuracy 7 < 10% + 0.2 mAs 
 

3  According to IEC 60601-2-63, par. 203.6.4.3.102.2 
4  According to IEC 60601-2-63, par. 203.6.4.3.102.3 
5  According to IEC 60601-2-63, par. 203.6.3.1.101 
6  According to IEC 60601-2-63, par. 203.6.4.3.102.4 
7  According to IEC 60601-2-63, par. 203.6.4.3.102.5 

 

INVERTER 
 

Make IMD s.r.l. 

Model HF1 3.5kW / HF1 3.5kW PLUS 

INPUTS 

Maximum power 3.5 kW 

Power supply 230 V~ (± 10%) 

Wave shape Sinusoidal 50/60 Hz 

Maximum current 16 A 

Power supply apparent resistance 0.14 ohm 

OUTPUTS 

Peak voltage 350 Vpk 

Maximum peak current 120 Apk Max. 

Wave shape Sinusoidal 20 kHz 

PHYSICAL DATA 

Dimensions 160 x 280 x 235 mm 

Weight 7 kg 

 

Dose declaration and Acceptance test 

Please refer to the attached document "Dose declaration and acceptance test" 
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Stray Radiation Map 

 

Stray radiation (uGy/mAs) according to IEC 60601-2-44:2009 Par. 203.13.  

Measured using “head phantom” according to IEC 60601-2-44:2009 Par. 203.108. 

 

 
 

Laser 
 

Output power 0.9 mW 

Wave length 635 nm 

Beam divergence 70º 

Pulse length Continuous wave 

Classification Class 1 (IEC 60825-1:2014) 
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Geometric relationship between the focal spot, the beam size, the patient position and the image reception area. 
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Other information 
 

Absorbed power 

220 V ~ (± 10%) / 230 V ~ (± 10%) / 240 V ~ (± 10%) 

50/60 Hz (± 1%) 

10 A (during the scan with maximum x-ray load) 

0.9 A (in stand-by mode) 

200 V ~ (± 10%) 

50/60 Hz (± 1%) 

12.5 A (during the scan with maximum x-ray load) 

1.1 A (in stand-by mode) 

100 V ~ (± 10%) / 115 V ~ (± 10%) 

50/60 Hz (± 1%) 

15 A (during the scan with maximum x-ray load) 

1.4 A (in stand-by mode) 

Network impedance ≤ 0,5 Ω 

Use temperature +10 ± +35 °C 

Use humidity 10% ± 85 % (non-condensing) 

Transport and storage temperature -20 ± +70 °C 

Transport and storage humidity 10% ± 85 % (non-condensing) 

 

Electromagnetic compatibility 

The device is intended for use in environments recognised as professional health facilities, as described in IEC 

60601-1-2:2014. The device belongs to CISPR 11 Class A Group 1 and complies with immunity test levels specified 

by IEC 60601-1-2:2014 for professional health facilities. 
 

Before using any electronic device in health facilities, always check that it is compatible with the other equipment 

present. 

 
 

Clause Guidance and manufacturer's declaration - electromagnetic emissions - for all 

equipment and systems 

TABLE: Guidance and manufacturer's declaration - electromagnetic emissions 

The NewTom VGi evo device is designed to operate in the electromagnetic environment specified below. The 

customer or user of the NewTom VGi evo device must ensure that it is used in such environment. 

Emission test Conformity Electromagnetic environment - guide 

RF emissions 

CISPR 11 Group 1 

The NewTom VGi evo device uses RF energy only for 

its internal operation. Therefore, its RF emissions are 

very low and they probably do not interfere with the 

electronic devices nearby. 

RF emissions 

CISPR 11 Class A 
The NewTom VGi evo device is suitable to be used in 

all rooms, except the domestic ones, and places 

directly connected to a public low-voltage line that 

supplies buildings for domestic purposes. 
Harmonic emissions 

IEC 61000-3-2 Class A 

Voltage fluctuations/ 

flicker emissions 

IEC 61000-3-3 
Compliant 
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Clause Guidance and manufacturer's declaration - electromagnetic emissions - for all 

equipment and systems 

TABLE: Guidance and manufacturer's declaration - electromagnetic emissions 

The NewTom VGi evo device is designed to operate in the electromagnetic environment specified below. The 

customer or user of the NewTom VGi evo device must ensure that it is used in such environment. 

Immunity test 
Test level IEC 

60601 
Conformity level Electromagnetic environment - guide 

Electrostatic 

discharge  

(ESD) 

IEC 61000-4-2 

± 8 kV by contact 

 

± 15 kV in air 

IEC 60601-1-2 

Test level 

Floors must be made of wood, concrete or 

ceramic. 

If floors are covered with synthetic material, the 

relevant humidity should be at least 30%. 

Transients/fast 

electric trains 

IEC 61000-4-4 

±2 kV for power 

supply lines 

±1 kV for 

input/output lines 

IEC 60601-1-2 

Test level 

The network voltage quality should be that of a 

typical commercial or hospital environment. 

Over-voltage 

IEC 61000-4-5 

±1 kV differential 

mode 

±2 kV common 

mode 

IEC 60601-1-2 

Test level 

The network voltage quality should be that of a 

typical commercial or hospital environment. 

Voltage drops, 

short blackout or 

voltage variations 

on the input 

supply lines 

IEC 61000-4-11 

Ut = 0% (at 0°, 

45°, 90°, 135°, 

180°, 225°, 270°, 

315°) for 0,5 

cycles 

 

Ut = 0% for 1 cycle 

 

Ut = 70% (at 0°) 

for 25/30 cycles 

 

Ut = 0% for 

250/300 cycles 

 

IEC 60601-1-2 

Test level 

The network voltage quality should be that of a 

typical commercial or hospital environment. If 

the NewTom VGi evo device user requires a 

continuous operation also in case of blackout, it 

is recommended to power the NewTom VGi 

evo with uninterruptible power supply (UPS) or 

batteries. 

Magnetic field at 

network 

frequency (50/60 

Hz) 

IEC 61000-4-8 

30 A/m 
IEC 60601-1-2 

Test level 

The magnetic fields at network frequency 

should feature levels typical of a standard 

commercial or hospital environment. 
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Clause Guidance and manufacturer's declaration - electromagnetic emissions - for all 

equipment and systems 

TABLE: Guidance and manufacturer's declaration - electromagnetic emissions 

The NewTom VGi evo device is designed to operate in the electromagnetic environment specified below. The 

customer or user of the NewTom VGi evo device must ensure that it is used in such environment. 

Immunity test 
Test level IEC 

60601 
Conformity level Electromagnetic environment - guide 

Conducted RF 

IEC 61000-4-6 

 

 

 

 

 

 

 

Radiated RF 

IEC 61000-4-3 

3 Vrms 

from 150 kHz to 80 

MHz 

 

6V  

ISM frequencies 

 

 

 

 

3 V/m 

from 80 MHz to 2.7 

GHz 

IEC 60601-1-2 

Test level 

 

 

 

 

 

 

 

 

IEC 60601-1-2 

Test level 

The RF communication devices (portable and 

mobile) should not be used near the NewTom 

VGi evo device, including cables, but should 

be located at the recommended distance 

calculated with the equation applicable to the 

transmitter frequency. 

 

Recommended distance: 

d = 1.2 * P 

 

d = 1.2 * P from 80 MHz to 800 MHz 

d = 2.3 * P from 800 MHz to 2.7 GHz 

where P is the maximum nominal output power 

of the transmitter in Watt (W) according to the 

transmitter manufacturer, and d is the 

recommended distance in meters (m). 

The field intensity of the fixed RH transmitters, 

determined based on an electromagnetic* 

analysis, could be lower than the conformity 

level in each frequency interval **. 

Interferences may occur near the devices 

marked with the following symbol: 

 
Notes: 

(1) At 80 MHz and 800MHz it is necessary to apply the distance defined for the highest frequency interval 

(2) These guidelines could not apply to all situations. The electromagnetic propagation is influenced by the 

absorption and reflection of structures, objects and people. 

 

*The field intensity for fixed transmitters like the base stations for radiophones (mobiles and cordless phones) and 

radio units, radio amateur devices, AM and FM radio transmitters and TV transmitters can not be defined 

theoretically and with precision. To assess an electromagnetic environment caused by fixed RF transmitters, one 

should consider performing an electromagnetic analysis of the site. If the field intensity measured in the place 

where a NewTom VGi evo device is used exceeds the applicable conformity level mentioned above, one should 

analyse the standard operation of the NewTom VGi evo device. If abnormal performance is noticed, it may be 

necessary to implement supplementary measures like a different orientation or position of the NewTom VGi evo 

device. 

 

**The field intensity in the frequency interval from 150 kHz to 80 MHz should be lower than 3 V/m 
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Clause Guidance and manufacturer's declaration - electromagnetic emissions - for all 

equipment and systems 

TABLE: Recommended distance between portable and mobile radio-frequency devices and the equipment 

The NewTom VGi evo device is designed to operate in the electromagnetic environment with control of the RF 

irradiated disturbances. The customer or the operator of the NewTom VGi evo device could help in preventing 

electromagnetic interferences ensuring a minimum distance between the RF mobile and portable communication 

devices and the NewTom VGi evo device as indicated below, in relation to the maximum output power of the 

radio-communication equipment. 

Specified maximum output power 

of the transmitter, W 
Distance at the transmitter frequency, m 

 

from 150 kHz to 80 

MHz 

d= 

from 80 MHz to 800 

MHz 

d= 

from 800 MHz to 2.7 

GHz 

d= 

0.001 0,037 0,037 0,072 

0.1 0.37 0.37 0.72 

1 1.2 1.2 2.3 

10 37.9 37.9 7.27 

100 120 120 23 

For transmitters specified for a maximum output power not indicated above, the recommended distance in meters 

(m) can be calculated using the equation applicable to the transmitter frequency. Where P is the maximum rated 

output power of the transmitter in Watt (W) according to the transmitter manufacturer. 

Notes: 

(3) At 80 MHz and 800MHz it is necessary to apply the distance defined for the highest frequency interval 

(1) These guidelines could not apply to all situations. The electromagnetic propagation is influenced by the 

absorption and reflection of structures, objects and people. 

 

All components, parts, spare parts must be approved and supplied by CEFLA s.c. 

In particular, the connection cables must be of the type specified in par. 4.8.1 - "Cables". 
 

 

DANGER: 

Using components, transducers and cables other than those specified may result in degradation 

of the electromagnetic compatibility characteristics of the device! 
 

 

WARNING: 

The NewTom VGi evo must not be located directly on another device, and other devices must not 

be positioned directly on the NewTom VGi evo device.  

If this is not possible, observe the NewTom VGi evo device to check its correct operation in the 

position it is going to be used! 
 

 

WARNING: 

Portable RF communications equipment (including peripherals such as antenna cables and 

external antennas) should be used no closer than 30 cm (12 inches) to any part of the device, 

including cables specified by the manufacturer. Otherwise, degradation of the performance of this 

equipment could result. 
 

 

NOTE: 

The emission characteristics of this equipment make it suitable for use in industrial areas and 

hospitals (CISPR 11 class A). If it is used in a residential environment (for which CISPR 11 class 

B is normally required) this equipment might not offer adequate protection to radio-frequency 

communication services. The user might need to take mitigation measures, such as relocating or 

re-orienting the equipment. 
 

 

Essential performance 

In case a scanning is interrupted because of a temporary or permanent malfunction, the operator will have the 

possibility to save the data acquired up to that moment. 

The quality of the reconstructed images will depend on the quantity of acquired data and will nevertheless be lower 

than that of images reconstructed based on a standard scanning performed without interruptions. 
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10. APPENDIX B: COMPATIBILITY  
 

The NewTom VGi evo device has been manufactured in compliance with the IEC standards for the safety of medical 

electrical equipment, and particularly with the following standards: 
 

• IEC 60601-1: 2005 + AMEND. 1 (2006) + AMEND. 2 (2007) + A1:2012 (Ed. 3.1) - General requirements for basic 

safety and essential performance. 
 

• IEC 60601-1-2:2014 (4th Ed.) - General requirements for basic safety and essential performance - Collateral 

standard: Electromagnetic disturbances - Requirements and tests. 

 

• IEC 60601-1-3:2008 + A1:2013 (Ed. 2.1) - Particular requirements for basic safety and essential performance of 

dental extra-oral x-ray equipment. 

 

• IEC 60601-1-6:2010 + A1:2013 (Ed. 3.1) - General requirements for safety - Collateral Standard: Usability 

including IEC 62366: Application of usability engineering to medical devices. 

 

• IEC 60601-2-63:2012 + A1:2017 (Ed. 1.1) - Particular requirements for basic safety and essential performance of 

dental extra-oral x-ray equipment. 

 

• IEC 62304:2006 + A1:2015 (Ed. 1.1) - Medical device software - Software life cycle processes. 

 

• IEC 62366: 2007 + A1:2020 (Ed. 1.1) - Medical devices - Application of usability engineering to medical devices. 

 

• IEC 60825-1:2014 - Safety of laser products - Part 1: Equipment classification, requirements and user's guide. 

 

• ANSI/AAMI ES60601-1: 2005 / A2:2010 - US NATIONAL DIFFERENCES Medical electrical equipment, Part 1: 

General Requirements. 

 

• CAN/CSA-C22.2 No. 60601-1:2008 - CA - CANADIAN NATIONAL DIFFERENCES to CAN/CSA-C22.2 No. 

60601-1:2014. 

 

IEC 60601-1 CLASSIFICATION 

Type of protection against electric shocks CLASS I 

Degree of protection against electric shocks TYPE B 

IP code 

(ingress protection) 
IPX0 

Use with anaesthetic mixtures This equipment has not been evaluated for use in the 

presence of a flammable anaesthetic mixture with air, 

oxygen or nitrous oxide 

Sterilisation and disinfection methods The device is not subject to sterilization. 

(See chapter 3.5 “Cleaning and disinfecting”). 

Use conditions Continuous operation with intermittent load. 

Operating cycle 

15 minutes for a complete operating cycle composed as 

follows: 

Device part: Duration of the operation: 

Column actuator and 

chinrest motors - 

movements 

Duty cycle:  

16% (2.20 min / 15 min) 

Beam limiter motors 
Duty cycle:  

6% (50 sec. / 15 min.) 

Scan motor - movements 
Duty cycle:  

14% (2 min / 15 min) 

X-ray emission 

Duty cycle:  

2% (max 36 sec. pulsed / 15 

min) 

110 kV-15 ms - 32 mA 
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11. APPENDIX C: DEVICE LABELS  
 

 

 

PLATE ON THE SCANNER 
 

   
 

Position: Right upright of the scanner, lower side 

 

 

CONTROL BOX PLATE 
 

   
 

Position: Left side of the control box 
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MAIN SWITCH AND INPUT FUSE LABEL 
 

 
 

Position: Left side of the control box 

 

X-RAY WARNING AND DHHS LABEL 
 

 
 

Position: Left side of the control box 

 

APPLIED PART LABEL 
 

 
 

Position: on the motor-driven chinrest 
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CONTROL BOX PLATE 
 

  
 

Ray source with rotary anode 

 

  
Position: On the X-ray source and inverter case 
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PLATE WITH DEVICE COMMERCIAL NAME 
 

 
 

Position: On the scanner cover, in the lateral central area 

 

 
 

Position: On the detector case, in central area 

 
 

cMETus CERTIFICATION LABEL 
 

 
 

Position: Left side of the control box, under the laser label 
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BEAM LIMITER LABELS 
 

BEAM LIMITER GLOBAL LABEL 
 

 
 

Position: Near the collimator assembly part no. 96600870 
 

BRASS FILTER LABEL 
 

CEFLA s.c. – Italy 

P/N 99934979 – CuZn – 0.15 

mm 

P/N 99935063 – CuZn – 0.25 

mm 

 

10.60 mm Al at 75 kV 
 

Position: Near brass filters part no. 99934979 and 99935063 
 

CANBUS CONNECTOR INDICATION LABEL 
 

 
 

Position: Left side of the control box, at the bottom 
 

X-RAY BUTTON CONNECTOR INDICATION LABEL 
 

 
 

Position: Left side of the control box, at the bottom 
 

RJ45 ETHERNET BUTTON CONNECTOR INDICATION LABEL 
 

 
 

Position: Left side of the control box, at the bottom 
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WARNING LABELS FOR LASER DEVICES 
 

 
 

Position: Left side of the control box, under the emergency stop button 
 

LASER DANGER LABEL 
 

 
 

Position: On the scanner, near laser modules 
 

LABEL INDICATING TO REFER TO THE INSTRUCTION MANUAL 
 

 
 

Position: Left side of the control box, at the bottom 
 

LABEL INDICATING THE HEAD COLLISION HAZARD 
 

 
 

Position: On the scanner rotary arm 
 

STOP LABEL 
 

 
 

Position: On the emergency stop buttons 
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CHINREST DEVICE LABELS 
 

                                                    

 

 
 

 
 

Position: On the chinrest covers 
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www.newtom.it 
 

NEWTOM™ is a commercial trademark of CEFLA s.c. 

 

All other products and brand names are registered trademarks 

or trademarks of their respective companies 

 

NEWTOM™ VGi evo is manufactured by: 

 

CEFLA s.c. 

 

Headquarters:   

Via Selice Prov.le 23/A  

40026 Imola (BO) Italy 

 

Plant:   

Via Bicocca 14/C 

40026 Imola (BO) Italy 

 

Phone: +39 045 8202727 

Fax +39 045 8203040 

e-mail: info@newtom.it 

 

All rights reserved. 

 

 
  

 

U.S.A. Cefla North America Inc. 

6125 Harris Technology Blvd. 

Charlotte, NC, 28269 United States 

 

Phone: +1 704 598 0020 

e-mail: info@ceflaamerica.com 

РОССИЯ / 

RUSSIA 

Адрес для обращения потребителей на 

территории РФ: 

ООО "Зенит Р.С." 

143051 Россия, Московская обл., 

Одинцовский р-н, ул. Городок - 17, 

владение 15, стр.3 

 

Тел.: +7 495 980 13 50; +7 495 234 97 

e-mail:  sales@zenith-rs.ru 

website: www.zenith-rs.ru 

 

УКРАЇНА / 

UKRAINE 
 

 
 

UA.TR.101 

 

Уповноважений представник в Україні: 

ТОВ “ДЕНТ ПРО” 

Юридична адреса:  62457, Україна, 

Харківська обл., Харківський 

р-н, смт Березівка, в’їзд Кооперативний, буд. 4 

 

Тел.:  +38(057)-714-07-12, +38(057)-714-07-13 

e-mail:  dentpro@dentpro.info 
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